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(Note: This booklet is designed to let you quickly master the latest additions to
Parashara�s light 7.0. This information is complimentary to the main manual.)
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Graha Explorer

By simply right-clicking on a planet in the birth chart, you get instant access to
a variety of features related to that planet. When you right click on a planet,
youwill see a popupmenu that let�s you do the following things:
- show a large compilation of significations of that planet, collected from
many classical texts
- show the planetary summary report with a compilation of numerous
calculations pertaining to that planet
- show aspects to and from this planet
- search for all yogas that involve that planet

CHAPTER 1

WORKSHEET ENHANCEMENTS

Chapter 1 : Worksheet Enhancements
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- search people in your chart database that have a most similarly placed
planet
- show a calendar with all transit activity of that planet in the upcoming
months
- search for upcoming transits of that planet over other planets in the
chart
- search for upcoming transits of other planets over that planet
- easily access display options (i.e. change from text to glyphs and vice
versa)

Significations
We combedmany classics to compile a rich set of significations for each Graha.
You can easily access these by right-clicking on a planet, and selecting the �Sig-
nifications� command. This will be very useful as a reference in many situa-
tions.

Fromhere, you can also see the significations for the lagna, other planets, signs,
bhavas, nakshatras, drekkana and panchang elements too, by selecting them
from the list box in the left upper corner or by clicking on the relevant tab.

Planetary info
To see an exhaustive summary of a planet�s strength, auspiciousness, and nu-
merous other factors, right-click on the planet and select �Show calculations�.
Many of the items in this report are hyperlinked, and you can click on them to
see further information.
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Aspects
To quickly see the aspects to any planet, and the aspects given by that planet,
right-click on that planet and select the �Show aspects� command from the
popup menu. A new �mini-worksheet� will launch, and show the aspects in
two graphs.
In the example below, Jupiter was right-clicked. On the left, the graph shows
aspect on Jupiter, and you can see a very strong aspect from Rahu (the tallest
bar). There is no aspect from Mars (no bar).

The graph on the right shows Jupiter �s aspects on other planets. In this ex-
ample, Jupiter gives a 100% full aspect on Moon (the tallest green bar), and a
90% aspect on Saturn and Rahu. These aspects are based on the exact degrees
between the planets, which is the classics� superior method of calculating as-
pects.

Yoga search
When analyzing a planet in the birthchart, it is often very good to be aware of
what yogas the planet is involvedwith. That ismade very easy now! Just right-
click the planet and select �Search yogas�. All yogas that have the planet in-
volved - in whatever possible way - will be found and listed.

Similar planets placement
If you like to see another chart with aMoon that is placed just like yours, right
click on the Moon (it could be any planet of course), and select �Show most
similar chart�. The tool will search for all charts that have a similarly placed
Moon as compared to yours. For example, if yourMoon is in Taurus/Rohini in
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the 4th house, the searchwill probably yield peoplewithMoon in the 4th or in
Taurus or in Rohini or combinations thereof. It will also try tomatch the same
conjunctions, if theMoon iswith other planets in the same sign. Of course you
need enough charts in your collection to expect a sizable result of this search.

Transit calendar
This command launches a transit calendar for one month at a time, with the
upcoming transits for the planet you clicked on. The Previous andNext buttons
allow easy navigation between months. You can specify what kind of transit
information you want included by clicking on the �Edit transit preferences�
button. Each calendar month will be printed on it�s own page.

Search transits of/over Graha
These two commands launch the �Time of transits� toolwhich is also accessible
from the Research menu. This will let you find the next transit of this planet
over any other specific planet, or the transit of any other planet over the one
you right-clicked on.

Example: Select the command �Search transits of Graha�, and you will see the
screen displayed below. All you have to do now, is select a natal planet from
the highlighted listbox.
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Let�s say you select Mercury. The tool will now calculate the first upcoming
transit of Mars over Mercury. If you right click on the date found, a popup
menu appears �Use for animated transits�. This will set the date/time of any
animated transit chart on the worksheet to this date.

Display options
There are a number of display options that pertain to planets and that are
accessible from the options menu. Now you can access them even easier by
right-clicking on the planet, and selecting the �Options� submenu. Refer to the
mainmanual for more details on these options.
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Nakshatra explorer

By simply right-clicking on a nakshatra
name in the chart, you get access to all
relevant features related to nakshatras.

Select �Nakshatra descriptions� to view
a much expanded overview of
Nakshatra attributes and meanings, with new material compiled from many
classical texts.

Select the �Show people with this nakshatra� command to view everyone you
have on file that has a planet in that nakshatra. The Search for charts tool will
launch, and automatically run the search on the charts in your charts folder.
You can click on any of the names to view the chart. In case you want to keep
this list handy for later reference, or if you want to print the list of names you
found, save the list to a chart group, and youwill be able to access it again using
the Filemanager from the File menu.

Bhava (house) explorer

Right-click on the name of any house as marked in the
outer rim, or any sign/housewithin the chart, to launch
the Bhava explorer menu. From this menu, you can ac-
cess a number of features related to bhavas.

Chart rotation
Select �Rotate chart to this house� to view the chart from this house as the
lagna. You can also rotate a super imposed chart like this. For example, this
would let you see transits around your birthchart from the perspective of any
of the 12 houses (only meaningful for the North Indian style chart or circular
chart).
Note: This feature is not so meaningful for South Indian style charts, as it does not
have houses in fixed positions.
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House Description
The house description command places a rich compilation of house significa-
tions and associations at your fingertips. This material is compiled frommany
classics, so it is entire authentic, yet very accessible.

Lordship placement
The interpretations of the house lord�s placement is a fundamental factor to be
analysed for any house in any chart. To access this material, right-click on a
house and select the �Lordship placement� command.

Bhava Bala
Just like Shad bala indicates how strong or influential planets are, Bhava bala
indicates the strength or �ability to manifest� for any house. Strong houses
tend to be more pronounced in life, and express their areas of life to a greater
extent. Areas of life indicated by weak houses tend to remain on the back-
groundwithout getting fullymanifested in life. Right-click on any house num-
ber and select �Bhava bala� to see the house strengths.

Search yogas
When studying the condition of a house, it is often useful to knowwhich yogas
a house is involved in. Simply right-click on the house number, and select the
�Search Yogas� command. You will automatically get a listing of all yogas the
house is involved in.

House aspects
Most people can easily see the major aspects to a house at a quick glance, but
few can see easily when a house and it�s lord are both aspected partly (1/2 and
¾ aspects) by the same planet, the effect of which adding up to the equivalent
of a full aspect. Right-click on any house and select �Show aspects�, to see the
aspects to that house.
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Rashi (sign) explorer

You can also right click on signs to get easy access to sign
related features that will help you learn and practice
Vedic astrology.

Rotate chart by sign
Right-click on a sign in the chart and select �Rotate chart to this sign� to treat
that sign as the Ascendant or 1st house. The most useful application of this
feature is to view the �natural zodiac� in the North Indian style chart by rotat-
ing the chart to Aries. When Aries is used as the first house, you can easily see
all the planets� sign positions as if they are house positions.

Sign description
Right-click on a sign and select �Sign description� to see a compilations of signi-
fications and attributes of the sign you clicked on. This material is gathered
from a number of classics.

Signs as glyphs
It is now very easy to switch back and forth between showing signs as text or
as glyphs. Right click on the sign, and select �Show as glyphs� or �Show as
text�(you can do the same by using the Fonts command from the Options
menu, and changing the sign font from Times to LightBasic II).

Compatibility

There are three newworksheet cells pertaining to compatibility scores. All three
are used in the new �Compatibility - kutas� worksheet.

Press F5 to launch the Worksheet selection dialog, and select the worksheet
named as �Compatibility � Kutas� from the compatibility section. Youwill see
an ashtkoota and dashkoota cell showing the traditional Indian koota scores.

You can also display the Ashtakoota and Dashkoota tables for any planets
other than the Moon, so you can calculate the compatibility for the various
areas of life the planets signify.
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A third cell, labeled �Rashi based compatibility� shows the distances of the
Lagna, Moon and other planets between 2 charts (as explained in �Light on
relationships� by Hart deFouw).

Chart drawing

For the South Indian style chart, you can now place the sign or house number
in any corner. For each corner, you can select one of the following:

1) the house number
2) the sign number
3) the sign name (abbreviated)
4) the sign name (in full)
5) the sign glyph
6) the house number (counted from

Moon)
7) the house number (counted from the

Sun)
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Displaying someone�s picture in their chart

In the Worksheet and in the Design Tool you
now have the option to place any image/
graphic to the inside of the birth chart. This is
great for adding a business logo or any other
graphic, or a digital picture of the person.

To show the picture of someone, first save the
picture (.jpg only) in the charts directory, us-
ing the same file name as the chart file. For
example, if the chart file is PrinceCharles.XML
then the image name should be Prince
Charles.jpg, and both should be in the same folder.

To actually display the picture, right-click on the chart, select advanced op-
tions, and select �show photo�. If youwant to show a logo image in case there
is no photo available for a particular chart, select the �show logo� option too.

Note: This feature is only available for the South Indian style chart.

Editable Worksheet headers

As per popular request, you now have the option to also show the city, state
and country of birth above the worksheet, besides the name and birthdate of
the person.

This option is available by rightclicking on the person�s name above the
worksheet. Youwill get a popupmenuwith these commands:
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- Edit Birth data: this is another way to get to the Edit
Birthdata screen
- Automatically open at launch: select this command to
open your chart automatically each time you start
Parashara�s Light
-Automatically open at launch as prashna: select this com-
mand to open a chart automatically each time you start
Parashara�s Light, using the current time as birth time
- Birth data details options: select this command to see
what birth details youwant to see displayed above the
worksheet.
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CHAPTER 2

TRANSITS ANDDASHAS

Chapter 2 : Transits and Dashas

Transits

There are various enhancements in Parashara�s Light 7.0 to let you use transits
better.

Transit interpretations
We searched for every possible source of transit interpretations from classics,
and compiled a unique transit report
based onwhatwe found.You get the best
of both worlds: authentic interpreta-
tions, yet presented in an easy to read
format. Access the transit report by se-
lecting the Reports menu, Interpreta-
tions, Transit Interpretations. You can se-
lect a starting date, and a period of time,
as well as the planets to be included in
the report.

Upcoming transits
A new worksheet cell �upcoming tran-
sits� will automatically show you the
upcoming sign ingress for each planet. So see this new cell, launch the Chart &
Table selection dialog by clicking on the place in theworksheetwhere youwant
to see the transits. Scroll two-third down in the first column (tables) to see the
section �timelines�. Select the last entry, �Upcoming transits�.
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To see all upcoming transits for a spe-
cific planet, right click on that planet
and select �Transit calendar�. You will
get a 3 month report for any transits
over signs, nakshatras, house cusps and
other natal points.

The transit/dasha report that�s avail-
able from the print menu is improved,
and now works for any year in the past or future. The results of a �time of
transit search� (accessible from the research menu) can now be used to set the
date of any animated transits based charts/tables in the worksheet. Simply
right-click on any of the dates found, and select �Use for animated transits�.

Dashas

The dashas cell in the worksheet is
quite a bitmore capable in Parashara�s
Light 7.0. Right click on the planet
name in the dasha cell to get a popup
menuwith several options:

Update animated transits
Select this command to see the transits for the date of the start of the dasha
you clicked on. You must have a cell with animated transits on the same
worksheet to see the effect.

Show dasha effects
Show dasha effects is a shortcut to go to the Dasha effects screen.

Advanced display options
Select Advanced display options to select addition datas to be displayed for each
dasha combinations. These datas can help evaluate the favorable or unfavor-
able outcome of the dasha.
Nakshatra distance is a similar principle to Tara bala, and expresses the favor-
able or unfavorable nature of the distance between the mahadasha and
antardasha�s nakshatras. For example, if the antardasha is placed in the 2nd
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nakshatra as counted from the mahadasha it is considered favorable.
Sign distance is the distance form the Mahadasha�s rashi to the antardashas
rashi. If that distance is 6, 8 or 12, it is unfavorable.
Dasha lord transit position shows the position of the dasha lords at the time the
dasha starts. This will quickly reveal if any dasha lords are in exaltation, own
or debilitation rashis, affecting that period accordingly.

Dasha calculation options
Dasha calculation options is a shortcut to the general dasha calculation options
screen, also accessible from the optionsmenu.

Dasha system selection
This command gives the same dialog as when you click on the title of this
worksheet cell. It will let you choose the dasha system, number of levels, and
planet based on which the dashas are calculated.



19

CHAPTER 3

NEWAND IMPROVEDTOOLS

Chapter 3 : New and Improved Tools

Panchang

Parashara�s Light now has a full fledged, authentic Panchang report. The con-
tent is fully user customizable, and can be seen on screen or be printed out. You
can design and print your own Panchang pages for any period of timewithout
limitations:
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- you can specify any location to be used for the calculations
- each column in the panchang is optional: date, tithi, nakshatra, yoga, karana,
sunrise, sunset,Moonrise/set, date, festivals, transits
- you can use hindu months or western calendar months as the time basis
- you can use any style chart (North or South Indian style charts etc.)

To open the Panchang tool select the Panchang command from the Printmenu.
Select the desired time period using the listboxes at the bottom. You can either
use theWestern calendar or theHindu calendar as the basis of the time periods.
Either way, the panchang will show around 2 weeks of data at a time.

Once you select the time period, you can navigate to following or previous time
periods within that year using the two buttons on the right labeled �<<� and
�>>�.

To change the columns displayed in the panchang, or to change other format-
ting details, click the options button.

Change place tool
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Launch the Change place tool by selecting the options menu, and choosing
�Change place tool�. You can also press F8. The tool will launch and display the
sign boundaries as relevant for the chart you have open at that time. This tool
has many new features as compared to the previous versions of Parashara�s
Light:

Navigation enhancements
- Theworld level map is much larger than before, which allows you to see a lot
more detail, and allows unlimited zoom in. Click the Zoom in button to zoom in
on the focal point (indicated by a red cross), and press Zoom out to zoom out
again.
- The focal point can be changedwithout updating the chart calculations. Just
click anywhere on the map, and the focal point will change to that location.
The mapwill be centered on that point, so this is a very intuitive way to navi-
gate around (sideways). If you shift-click, the map will zoom in, and if you
Ctrl-click the map will zoom out. Only when your click the �Update chart�
button, the natal chart will be relocated to the focal point.
- The change place tool now supports very large map previews. Regardless of
your monitor size, you can get a screen fillingmap! Just select the desiredmap
size from the map size list at the center top of the tool (the illustration has
800x600 selected).
- As you zoom in on any continent or country, therewill often bemore detailed,
local maps for that region, allowing you to see the exact boundaries of the
signs, relative to cities and other geographical details.
- The listbox that is next to the Zoomout button lets you select cities from a list
of cities that are placed on this map. This is very practical, as such cities are
usually the only options considered for relocation.

Calculation enhancements
- Not only Rashi boundaries, but also Navamsha boundaries are shown. Given
the important use of Navamshas in Vedic astrology, this is a great way to be
more specific in your evaluation of the auspiciousness of specific regions. For
example, when a person has exalted Jupiter in the Navamsha, you would con-
sider all Cancer Navamsha zones especially favorable for spiritual growth and
general well-being. This allows a lot more choices as compared to only using
Lagna zones or only planetary lines. In fact, it substitutes for planetary lines in
a powerful way: just consider the Navamsha line a planet is in, and you get 9
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zones instead of 1 line!
- The change place tool can be used for the birthchart (relocation) but also for
special muhurtas. For example, you could use it to look for a favorable place to
celebrate your birthday! Just select the desired chart from the listbox at the top
right to change between the Birthchart, Muhurta or animated transits as the
basis.

Tutorial

Parashara�s Light 7.0 has a more complete tutorial with a lot of additional ma-
terial for planetary/sign/house significations, and a lot of newnakshatramate-
rial. A rich introduction is added.

The descriptions screen has been changed to bemore appealing anduser friendly,
using tabs to select the various types of content. Just right click on any planet,
sign or house and select the significations command to access this material.

Calculations

After checkingwith an expert Sanskrit scholar,we discovered that theDrekkana
bala calculation as indicated in Brihat Parashara Hora Shastra was mistrans-
lated, and incorrect. To allow anyone to see the difference, the Drekkana bala
calculationmethod is now a new calculation option.

The 64thNavamsha and 22ndDrekkana are now shown fromLagna andMoon,
and added to the �Yogi & Dagdha� cell. To show this cell on any worksheet,
click on the positionwhere youwant this cell, and select �Yogi&Dagdha� from
the Tables menu. Moon rise and Moon set time is added to the Astronomical
printout.

Reports

The Monthly Progression for all 12 months of a year can be printed conve-
niently on one page for any specific year. This makes it very easy to track one
year�sworth ofMonthy charts. To access this new report, select theVarshaphala
submenu under the Reports menu, and choose the last command, Monthly
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charts. You can specify the age atwhich youwant to see the 12monthly charts.
In version prior to PL7, you could see the Varshphal dasha effects report only
for Muddha dashas.

In version 7, this report can be generated for all 4 types of varshphal dashas.

The astrologer�s name, address, phone number etc. can now be printed on all
the printouts. This informationwould be appended to �Licensed to xxxx yyyy�
at the bottom of each page. You can specify this text by selecting the �Cover
page text� command from the Edit menu. To activate the use of this text as
footer, select system options from the Options menu, and check use it in the
Astrologer�s details footer section.
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CHAPTER 4

DATA ENTRY AND FILE MANAGE-
MENT

Chapter 4 : Data Entry and file Management

Atlas

Major improvements to the atlas have beenmade, taking care of manyworld-
wide changes in time zone and daylight savings patterns in the past years. The
entire atlas of Canada is redone, reflecting the addition of a new state a few
years back, addingmany cities, and correcting inaccuracies in daylight savings
lookup. This feature alone makes upgrading worthwhile!
For India, the Atlas now shows the state or province in the case there are mul-
tiple citieswith the same name,which is helpful in decidingwhich is the correct
city.

Events and notes

Saving muhurtas
After you have done amuhurta chart for someone in PL, you can now save that
muhurta as an event so you can keep itwith the same record. To save aMuhurta
date, select the Edit menu, and select �Events�. On the left side, you will see a
list of all events for that chart. Select �Muhurta� from that list, and youwill see
the date, time and place for the muhurta on the right side. To convert this
Muhurta to a regular event, click on the �Save as event� button in the right
bottom corner. You will be prompted to enter a name for this new event. For
example, if the muhurta was for a wedding, you would save the muhurta as a
new event called �Wedding�, or �Weddingmuhurta�.
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This feature can also be used repeatedly to store vari-
ous alternate muhurtas that are being considered.
Once the final muhurta is selected, you can delete the
ones that are not being used, by selecting such
muhurtas and clicking the �Remove event� button.

Note that the �Save as event� button is only displayedwhen
the muhurta event is selected. It serves no purpose for other
events.

Instead of storing alternate Muhurtas as events, you
can also use the picklist on the Change time tool to
store the list ofMuhurtas:
-Make sure the Change time tool on the Muhurta
worksheet has �Muhurta� selected at the top
- AddMuhurtas to the picklist by clicking the �Add to
picklist� button at the bottom of the tool.
- Click on the picklist (which shows �Edit Date�when
no date from the picklist was selected yet), and select
any of the stored dates from the picklist to go back to
that Muhurta.
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Unlike prior versions of Parashara�s Light, the picklist will be saved along with
the birth and event data when you save the chart.

Using events
The event list can now be sorted by date, so you see all your events in chrono-
logical order. To sort events, first launch the Edit Event data screen from the
Edit menu. Now click on the �Sort Event� button to sort the events by date.

In prior versions of Parashara�s Light, one had a list of 20 events, all called �New
event� that could be edited when actually used. No events could be added or
removed. In Parashara�s Light 7, a new chart will have just one event called
�Newevent�, and you can add anunlimited number of events to that list. Events
can be added and removed on the Data Entry screen, on the Events tab. Just
click the �Add event� button to add a new event. To remove an event, select it
from the events list, and click the �Remove event� button.

File management

New file format and location
As of Parashara�s Light 7.0 (PL7), charts are stored in XML format. There are
many benefits to this change:
- the number of events that can be stored with a chart is now unlimited
- the size of notes stored with the chart, and notes stored with events are no
longer limited in size
- you can edit the birthdata outside of Parashara�s Light, in any text editor(this
may rarely be necessary, but can be useful in special occasions).
- You will never have to convert charts again in the future, as XML is a flexible
format that allows future changes

If you got Parashara�s Light as an upgrade, you need to import the charts from
your previous version of Parashara�s Light, or any backup you may have:
- launch the File Manager from the File menu
- click on �Import old charts�, and browse to the directorywhere your previous
charts used to be (for example c:/pl61/charts)
- press Ctrl+A which should highlight all chart files. Alternatively, you can
click on the first file in the list of files youwant to import, and shift-click on the
last one, whichwill also highlight all chart files
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- click on OK to start the import
- All fileswill be converted toXMLand copied to c:/GeoVision/GeoVisionCharts

Charts and optionswill no longer be stored in a charts directory in the applica-
tion directory. From PL7 onwards, charts will be stored in a folder GeoVision/
GeoVisionCharts and options will be stored in a folder GeoVision/
GeoVisionOptions. All other newapplicationsmade byus, such as ShriMuhurta
2.0 and Vedic Astrology bookshelf 1.5, will be using these same directories.

Sorting and organizing

Sorting
Charts can now be sorted by birth month. This is very nice for locating any
upcoming birthdays amongst your clients, friends and family. To sort by birth
month, open the File Manager (File/File Manager) and click on the �Change
Sort� button. Select �By birthday� from the available options.

Automatically open charts at launch
You can now select any chart(s) to be opened automatically when Parashara�s
Light is started. This offers various exciting possibilities. For example, you can
set it up so your own chart is always opened, showing the current transits and
dashas. To select a chart to be opened automatically at launch, first open it (by
using the File Manager or from the most recently used file list). Next, right
click on the name in the worksheet title, and select �Automatically open at
launch�. The chart will be opened every time you start up Parashara�s Light,
until you right click on the name in the worksheet title again, and select �Do
not open at launch�. If youwould like to see the current transits each time you
open the program, you can use the �Automatically open at launch as Prashna�
command:

1. First create a chart for your locality, i.e. if you live in Atlanta, create new
chart named �Current transits for Atlanta�, and set the city to Atlanta. The
date/time does notmatter.
2. Save it
3. Right click on the name above theworksheet (�Current transits for Atlanta�
in this case) and select �Automatically open at launch as Prashna�
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4. Next time you open Parashara�s Light, this chart will automatically open,
and the date/time of that chart will be set to the current date/time (based on
your computer clock).

Organizing your charts
Since PL6.1, it is possible to organize your charts in groups. To create a group,
run the FileManager (select the Filemenu, and the Filemanager command). In
the left bottom corner you will see a list titled �Groups�, which has one entry,
�all charts�. This is the default group in which all chart are found. Add a new
group by right clicking on �all charts� and selecting �newgroup� from the popup
menu.

You can now save your charts directly into such groups, so you can find them
back easily. For example, you could save new charts to a group �clients�, �fam-
ily�, or �research�. To save a newly created chart into any of the groups you
have created, select the Filemenu, and click on �Save to� instead of �Save�. The
Save to submenu will list all your available groups. Remember, you can add
any number of additional groups within the Filemanager.

Existing chart files can also easily be sorted out into those groups. Open the
Filemanager, and select the �Unfiled� group.This special group contains all charts
that you have not sorted out yet. Right click on any of them, and select �Assign
to group�, and the group you want it in. As soon as you assign a chart to a
group, it will be removed from theUnfiled group. Thatway you can efficiently
sort out your charts!

If you change yourmind about the name you have given to your groups, don�t
worry, they can be edited easily. Just right click on the group and select �Re-
name group�.

You can also remove groups you no longer want. Just right click on any group,
and select the �Delete group� command to remove it. The charts that were in
that group will NOT be deleted. Groups are purely �virtual�, and adding, re-
naming or deleting groups does not affect your chart files.

The birthdatas of all charts in a group can be exported to a tab delimited text
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file. Just right-click on a group, and select �Export Birth chart�. This list will be
alphabetically sorted, giving the name, birth date, birth time, and location of
all the files in that group. Alternatively, you can export all chartswithin a group
to one single quick chart file.
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